USB to RS-485 Adapter

User’s Manual

UTS-485UlI (RJ-45 Male Connector)




USB to RS-485Ul Adapter User’s Manual

Table of Contents

I [N o Yo [0 Tox o ] o PSSR S PSPPSR 2
FRATUIES . ettt ekttt b bt ekt e e b e oo b e e e e b et e e R b et e e R et e e e e R e e e b e e anr e nes 2
SPECITICALION Lot e st e e et e s te et e e Re e s be et e eseeete e teeneenaeenneeneeareeeeas 2

P2 11157 = 11 = 14 o ¥ o PSP 3

3. UTS-485UI ApPlication OPEIratiON .....ccociiiiiiieieieieeste sttt nb e 7

/O L 1 13 = 1 OSSP 11

5. DIIVEE INSTAITALION ...ttt bbbt bbbt e et e bbb bt e s e 12

WIiNdows OS INSTAlatioN GUIAE ......ccoiiiiiiiee ettt es 12

Driver Installation thru the FTDI Driver PACKaAgQe ........ccccvoviiieiicecicse e 15

Windows 98SE INStallation GUIAE .......cciiiiiiieiieie ettt aneas 18
@ T T 1] €= U1 ET g Yo T 13 U o o o SR R 24
TrOUDIESNOOTING .ttt n bbb ene s 26

WiIindows 2000 INStAllatioN GUIE .......ccuviieiieeiiesieeie ettt sre et esaeeeesreenes 27
UNINSTalliNg INSTIUCTION ..ottt bbb 32
TrOUDBIESNOOIING ..ot e st e st e e e e e te e e ra e re e 34

WIiNdows CE INSTAllation GUITE ......ccveiiiiiiiee ettt sne e nneenns 35
TrOUDBIESNOOIING ..ot e et e e s e et e e e e e e reenee s 37

WIiNndows XP INSTallation GUIAE........ooiiiiiiiiiiieeee ettt sneeneas 41
UNINSTAliNG INSTFUCTION ..o.viiiicecc ettt te e r e e teenaesneenas 49
TrOUDIESNOOTING .ttt b et bbb 50

Windows Vista (Win 7, 8, 8.1, 10) Installation GUIde.........cccccceeieiiiiiiicieece e 52
UNINSTalliNg INSTIUCTION ..eiiiiiiiec bbbt 56

MAC OS X INSTAllationN GUIAE....cc.eiiieiiiiie ettt ettt be b nreens 59
UNINSTalliNg INSTIUCTION ..ot bbbttt ettt 63
TrOUDBIESNOOIING ..ottt e st e e e et e e r e ra e re e 64

6. RegUIAtOrY COMPIIANCE .. .ottt bbbt 66



USB to RS-485Ul Adapter User’s Manual

1. Introduction

USB to RS-485 adapter provides an extra Serial Com port via USB connection and can be configured to work
with RS-485 peripherals such as POS and Industrial Control devices. USB to RS-485 adapter allows configuring
such as Echo through application software. Termination Resistors and Bias can be set as good solution for
saving time without manual setting. It supports USB Plug and Play; and serial port expansion. No IRQ, DMA, or

I/O port resources required.

Features:

compliant

YV VVVVVY VY

Supports Data transfer rate up to 3M Baud
Supports plug and play and hot swappable function
No external power supply required
Supports +15Kv ESD protection (HBM)
Allows single unit connecting up to 32 devices on the network
Compatible Windows OS 98SE / ME / 2000/ XP / Vista/7/8/8.1/10/ 11; Windows Server 2003 / 2008 /
2008R2 /2012 / 2012R2; Win CE OS, Mac OS 8.6, Linux OS 1.5.0 or higher.

Fully Compliant with USB specification 1.1 and 2.0

Echo mode/Bias resister/Terminal resister set up by Windows application program, Mac or Linux OS

Specific:
Model No. UTS-485UI RJ-45 Pin Assignment
Chip FTDI Pin 1 D+
Data Transfer Rate Up to 3M Baud Pin 2 D- —
USB Specification USB 1.1/ 2.0 compliant Pin 3 NC
Upstream USB Type A Male Pin 4 NC
Connector : : |
Device 8P8C RJ-45 Male Pin 5 NC |
Cable Length 1.8m Pin 6 NC LN
Power Mode Bus Powered Pin 7 NC b [
Housing Plastic Pin 8 GND
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2. Installation

To install the UTS-485Ul AP software, please confirm the points below:

a. The demo steps are operated on Windows

b. Make sure that Microsoft .NET Framewaork 4 version is installed on your computer
To download it, please visit its official website:
http://www.microsoft.com/en-us/download/confirmation.aspx?id=24872

c. Install the program with administrator privileges.

d. Make sure the device driver is installed.

Note:

FTDI Chip drivers can be downloaded and setup with Windows OS 2000 or higher by Windows Update. To
update drivers, please unload old version, then re-plug device, Windows Update will detect and update
automatically. (Above requires internet connected). Any unknown problem while installing, please install the
driver from CD, you can refer to page 13.


http://www.microsoft.com/en-us/download/confirmation.aspx?id=24872

USB to RS-485Ul Adapter User’s Manual

Steps:
1. Double click the RS-485_ AP _Installation_V13.10.1.msi to install

1

| RS-485_AP_Insta
| llation_V13.10.1.
‘ msi

2. Click “Next” to continue

2 _,
1) Rs-485 AP ESREE )
>

Welcome to the R5-485 AP Setup Wizard .l

The installer will guide you through the steps required to install RS-485 AP on your computer.

WARNING: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.
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3. Select install folder or use default, click “Next” to continue.

[ ) Rs-485 AP " =
Select Installation Folder v R
3_?1 “ j
B %
The installer will install BS-485 AP to the following folder.
To install in this folder, click "Next". To install to a different folder, enter it below or click "Browse".
Folder:
C:\Program Files\RS-485 4P\ [ Browse... ]
| DiskCost.. |
Install RS-485 AP for yourself, or for anyone who uses this computer:
@ Everyone
) Just me
[ Cancel ] [ < Back ] E o Nest> |
4. Click “Next” to start installation
-~
1) Rs-485 AP . canlei=)
Confirm Installation v R
-
_'“‘"\_/}

The installer is ready to install RS-485 AP on your computer.

Click "Next" to start the installation.

Cancel ] [ < Back ] [ Next >
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5. Please wait 2~3 min until the installation is completed

) Rs-485 AP i | e sl

—

|
Installing RS-485 AP

RS-485 AP is being installed.

Please wait...

E Cancel ; , < Back J , Next >

6. Click “Close” to exit.

) RS-485 AP

——

|

Installation Complete

RS-485 AP has been successfully installed.

Click "Close" to exit.

Please use Windows Update to check for any critical updates to the .NET Framework.

Cancel ‘ , < Back ‘ [ Close ]
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3. UTS-485Ul Application’s Operation

“RS-485 AP Logo” Icon should appear on the desktop, double click it to start

Please refer to p.13 for the driver’s installation)

RS-485 Application
) Echo Enable ) Echo Disable

) Echo+Terminal = Terminal
~ Echo+Bias = Bias

) Echo+Terminal+Bias = Terminal+Bias

Check Status S T ART
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2. RS-485 Device Manager will detect all UTS-485Ul devices connected to the PC, click “Device selection”
drop down to select device.

& RS-485 Device Manager w ]
Device selection Serial No.
l -]
Devicelll
RS-485 Application
) Echo Enable ) Echo Disable
| ) Echo+Terminal @ Terminal "
) Echo+Bias ) Bias
[
) Echo+Terminal+Bias ) Terminal+Bias
Status
||
START
Exit

3. In this case we may select Device01l, and then it may detect and show its Serial No. automatically.

[ g Rs-485 Device Manager %ﬂu
Device selection SerialNo.
DeviceDl] & DEWBSOCI
RS-485 Application
© Echo Enable ' Echo Disable
© Echo+Terminal = Terminal
) Echo+Bias © Bias
© Echo+Terminal+Bias © Terminal+Bias
| Stos
START
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4. Operation for setting Device01: click ‘Echo+Terminal’ for the device’s application setting and then click
“START".

48 RS-485 Device Manager

Device selection '
Device01 v DEWBSOCI

RS-485 Application
©) Echo Enable © Echo Disable

@ Echo+Terminal = Terminal

) Echo+Bias = Bias

) Echo+Terminal+Bias = Terminal+Bias

5. Wait until the block of the ‘Serial No.’ displays blank, and you have finished the device’s application setting
successfully.

## RS-485 Device Manager

l Device selection
Device01 v

: RS-485 Application
i ) Echo Enable ) Echo Disable

@ Echo+Terminal = Terminal

= Bias

) Echo+Bias

) Echo+Terminal+Bias = Terminal+Bias

Status Successfully set!]

START

6. To confirm device’s application setting, while UTS-485Ul is still connected to the PC, Select device again then
9



USB to RS-485Ul Adapter User’s Manual

click “Check Status”.

$& RS-485 Device Manager

' Device selection Sen'a.lNo.w -
Device01 v DEWEBSOCI

: RS-485 Application
l ) Echo Enable = Echo Disable
@ Echo+Terminal = Terminal

) Echo+Bias = Bias

=) Echo+Terminal+Bias = Terminal+Bias

Status  Echo+ Terminal Resister

START

Congratulation! You have finished setting the UTS-485UI device successfully.

10
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4. Uninstall

1. Enter “Control Panel” and click ‘Programs’ to uninstall a program. Locate the ‘RS-485 AP’ and click to
uninstall.

#% Realtek Ethernet Controller Driver Realtek
[m]Realtek Ethernet Diagnostic Utility Realtek

inition Audio Driver Realtek Semiconductor Corp.

[m7]RS-485 AP 18102013

. Skype Technologies S.A.
[ SmartCard Reader Driver Installation Alcor Micro,Crop.
[®7]ST Toolset STM

2. Click “Yes” to remove.
Note: If you fail to uninstall the RS-485 AP, please unplug the device and repeat above operations again or
reboot your computer and then uninstall.
.

RS-485 AP

~

ﬂﬂ! Please wait while Windows configures RS-485 AP

n | Cancel

11
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5. Driver Installation
Windows OS Installation Guide

Driver can be installed through Windows Update automatically (Internet connection needed)

The FTDI drivers that have passed the WHQL tests are available for download using Windows Update.
OS requirements: Windows 7/8/8.1/10/11

Please go below ways for easy installation.
1. You may plug the device into host computer. And then it will pop up ‘Installing device driver software’ from the

taskbar of the screen. (Fig. 1) Click and connect to the Windows Update.

2. It will check your computer OS and download the applicable driver at the Windows Update automatically.

Installing device driver software % *
Click here for status.

Fig. 1

3. The program goes ‘Searching Windows Update’ from ‘Driver Software Installation’. (Fig. 2)

" Driver Software Installation

Installing device driver software

Generic USB Hub E
USB <-> Serial {_J Searching Windows Update...

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update

Fig. 2

4. When the applicable driver is detected, it will run ‘Installing device driver software’. (Fig. 3)

| Driver Software Installation

Installing device driver softwagg

USB <-> Serial | {_/Searching preconfigured driver folders... I

Fig. 3

12
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5. Then it shows ‘USB Serial Port (COM8) installed’. Click ‘Close’ and go next step. (Fig. 4)

_J Driver Software Installation

Your device is ready to use
USB Serial Converter +/ Ready to use
USB Serial Port (COMS) »JReady to use

Fig. 4

6. Check ‘Device Manager’ of Control Panel from the computer OS and there shows USB Serial Port (COMS8)
under ‘Ports (COM & LPT)’; the other one shows USB Serial Converter under ‘Universal Serial Bus controllers’.
(Fig. 5) Congratulation! You have finished installing the USB to Serial device successfully.

ra Device Manager - LE@&
File Action View Help
e @0 HE & &S

&¥ Network adapters -
. B4 Portable Devices
477 Ports (COM & LPT)

2 Processors

»-%| Sound, video and game controllers
l >-{M System devices

| 4 ﬁ Universal Serial Bus controllers
Generic USB Hub

Generic USB Hub

Generic USB Hub

USB Root Hub

USB Root Hub

USB Root Hub

USB Root Hub

USB Root Hub

USB Root Hub

m

sf sf sf sf sf sf sb s L &)

Cammdmed L hmie e | D/ T o 1ICD

Fig. 5

NOTE: It may occur when driver is not installed successfully, please check below steps.

1. There is busy on access databank of Microsoft's Support link. Please try again or install driver of CD-ROM
provided.

2. Check your internet if it is failed to access Microsoft’s Support link.

3. Check your computer configuration if it is disabled on Windows Update wizard.

| Driver Software Installation l
Device driver software was not successfully installed

Please consult with your device manuffcturer for assistance getting this devicCinstalled.
USB <-> Serial K No driver found

What can I do if my device did not install properly?

Close

13
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Driver Installation thru the FTDI Driver Package
Driver can be installed through the FTDI driver package of the CD-ROM provided.

1. Double click ‘Setup_v2.12.00 WHQL Certified For Windows OS_x86.x64.exe’

| : * é ' ’

Linux(1.5.0) Mac OS 8_9 Mac OS X 10.9 Windows Windows
and above(2.3) 98ME(1.09.06) 2000(2.06.00)

L —

m

B 4 |

Windows CE Windows RT XP,2003,Vistaff0 | Setup_v2.12.00
42-52 6.0 Mo 8,8.1,200BR | WHQL Certified
bile For Windows
2003,2003SE,5... | OS_x86.x64.exe

2. It will pop up ‘FTDI CDM Drivers’ from the screen. Click ‘Extract’ and go next step.

[ l

FTDI CDM Drivers

Click 'Extract’ to unpack version 2,12.00 of FTDI's Windows
driver package and launch the installer.

www ftdichip.com

Cancel

15
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3. Extracting Files

[ ™

Extracting Files
FreeExtractor is extracting the compressed files in this archive.

Flease wait while the files in this archive are extracted.

Extracting Static/i386/ftd2xclib ...

4. Click ‘Next’ to continue.

- _
Device Dnver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Nest.

16
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5. Select ‘I accept this agreement’ and click ‘Next'.

Device Driver Tt C

License Agreement

To continue, accept the following license agreement. To read the entire
- agreement, use the scroll bar or press the Page Down key.

IMPORTAMT MOTICE: PLEASE READ CAREFULLY BEFORE -
INSTALLING THE RELEVANT SOFTWARE: |:|
This licence agreement (Licence)is a legal agreement between you
(Licensee oryou) and Future Technology Devices Intemational Limited

of 2 Seaward Place, Centurion Business Par, Glasgow G471 THH,
Scotland (UK Company Mumber SC136640) (Licensor or we) for use of
driver software provided by the Licenson(Software).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE -

(@ | accept this agreement: Save fs ] [ Brirt
() ' dont accept this agreement

<Back | New> || Cancel

6. The Device Driver Installation Wizard will detect your computer OS and install the applicable driver
automatically.

Boevice Drives Tt

The drivers are now installing....

- & .

Flease wait while the drivers install. This may take some time to complete.

< Back Next =

17
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7. While the Device Driver Installation Wizard is completing, click ‘Finish’ to exit.

'S ™
Device Dnver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. F your device
came with instructions, please read them first.

Driver Name Status

w” FTDI COM Driver Package - Bus/D2¥... Readyto use
w” FTDI COM Driver Package - VCP Driv... Readyto use
4 1

[ Cancel

Windows 98SE Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the uninstalling instruction.

Download the latest available drivers from the FTDI website and unzip them to a location on your PC.
Connect the device to a spare USB port on your PC. This will launch the Windows Add New Hardware
Wizard. Windows may display a message reading "Building driver database" at this point which may take a
few minutes to pass. Click "Next" to proceed with the installation.

Add New Hardware Wizard

This wizard searches for new drivers for:

USB <-> Serial Cable

A device driver is a software program that makes a
hardware device work.

18
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Select "Search for the best driver for your device. (Recommended) as shown below and then click "Next". -

Add New Hardware Wizard |

‘What do you want Windows to dao?

(& Search for the best diver for your device.
{Recommended).

¢ Display a list of all the drivers in a specfic
location, so you can select the driver you want,

< Back I Next > I Cancel

Check the box next to "Specify a location" and uncheck all others as shown below. Click "Browse" and
locate the driver files. Once the files have been located, click "Next" to proceed with the installation.

Add New Hardware Wizard I

Windows will search for new drivers in its driver database
on your hard drive, and in any of the followng selected
locatons. Click Nexst to start the search.

[~ Foppy disk drives
[~ CD-ROM drive
[T Microsoft Windows Update

[V Specify a location:
fc:s =l
Browse... I

< Back I Next > I Cancel I

19
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Windows may display a message reading "Building driver database" at this point which may take a few
minutes to pass. Once Windows has found the required files, click "Next" to install the device.

Add New Hardware Wizard

‘Windows driver file search for the device:

USE Serial Converter

\Wincows is now ready ta install the best driver for this
device. Click Back ta select a different driver, or click Next
to continue.

Location of driver:

=) C:AVCPDRI~INFTDIBUS.INF

Cancel

If the driver being installed does not have Microsoft WHQL signature files (.CAT files), the wizard will request
a driver disk to attempt to find them. Click "OK" on the "Insert Disk" message box.

Insert Disk

Q Please insert the dis< labeled 'FTDI USB Drivers Disk', and then click OK.

The following window will appear to assist in locating the file. To proceed with the installation without
the .CAT file, click "Skip File".

I x|
The file 'ftdibus.cat on FTD1 USE Drivers 0K

e Disk cannot be found.

Cancel
Insert FTDI USB Drivers Disk in the selected
drive, and click OK.

Skip File

Details...

Cooy files from:
T LI Browse...

CAVCP Drivers

I L

20
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If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other
driver files and should be installed automatically.

Windows should then display a message indicating that the installation of the serial converter driver was
successful. The COM port emulation driver must now be installed. Click "Finish" to complete the installation
of the serial converter and proceed to the COM port emulation driver.

Add New Hardware Wizard

E USE Serial Converter

Windows has finished installing the software that your new
hardware device requires.

Cancel |

Under Windows 98SE, the COM port emulation driver will be automatically installed from the same location
as the serial converter driver. However, if the driver is not WHQL certified as explained above for the serial
converter driver, the wizard will ask for the location of .CAT files. Click "OK" on the "Insert Disk" message

box.
Insert Disk |

Q Please insert the dis< labeled 'FTDI USB Drivers Disk', and then click OK.

21
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The following window will appear to assist in locating the file. To proceed with the installation without

the .CAT file, click "Skip File".

The file 'ftdiport.cal on FTD 1 USB Drivers
Ty Disk cannot be found.

Insert FTDI USB Drivers Disk in the selected
drive, and click OK.

Cooy files from:

C:\WCP Drivers _:_l

DK

Cancel

Skip File

Details...

PR Gl

Browse...

If the driver being installed is Microsoft WHQL certified, then the
driver files and should be installed automatically.

Open the Device Manager (located in "Control Panel\System" then select the "Device Manger" tab) and
select "View devices by type". The device appears as an additional COM port with the label "USB Serial

Port".

System Properties

Generd  Device Manager |Hamare Frofiles | Performance |

% View devices by tyoe " View devices by connection

.CAT files will be located with the other

2] %]

#-@2 Keyboald

& Moden

M Moritees

B 7 Mouse

i1 MutiOContraler
[+ 9 Network adapter:
=¥ Ports (COM & LPT)
i Commerications Port (COM1)
5 PCIECP/EPP Port (LPT1)
7 PCl Seiial Pat (COM2)

Wl Systemn devices
Unwversal Serial Bus controllers

-8

Universal Serial Bus cortiollers

+

Propetties | Hefresh I Remove I

|

i«

L ]

Canrel |

Please note:
22
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1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:

www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".

23
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Uninstalling Instruction

To uninstall drivers, follow the instructions below:
Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control PaneNAdd/Remove Programs". Select "FTDI
USB-Serial Converter Drivers" from the list of installed programs.

Add/Remove Programs Properties Bm

Install/Uninstall | Windows Setup | Startup Disk I

To nstall a new program from a floppy disk or CD-ROM
; dnive, click Install.

Install...

'.:'—/ The following software can be automaticall removed by
] Wirdows. To remove aprogram or to madily its installed
components, select it from the list and click
Add/Remove.

Chinese [Traditional] Language Support

FTDI LSB-toS

verial Converter Drivers
GetRight

InstantCD/DVD —I
Internet Explorer Q828750

Japanese Language Support

KemelDriver

Key Drive 1.0

Korean Language Support _‘_J

Add/Bemove... l

oK | cCancel | spib |

24
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Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the
uninstaller or "Cancel" to exit.

FTDI Uninstaller ¥3.0 | X

If your USB device is connected, please unplug it now...

Press Continue to uninstall the drivers, or Cancel to quit.

Continue I

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button
will change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller ¥3.0 X

Uninstalling ¥ID_0403%PID_6001

Deleting registry entries...
Deleting files...

Uninstall complete, press Finish to exit.

[Eontmue I

25
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Troubleshooting

1. Windows 98SE cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USBView utility from the FTDI website. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed the VID and PID entries in the driver
INF files. If they do not match, that driver cannot be installed for that device without either re-programming
the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note that only your
own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your company should be
used in the EEPROM and INF/INI files.

2. Windows 98SE forces areboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy
it. This usually occurs with the FTD2XX.DLL file. If installing a D2XX device, selecting not to restart the
computer then unplugging and re-plugging the device may allow the device to function properly without
restarting. Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 98SE gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices),
or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being
incorrectly installed. Please refer to the example schematics on the FTDI website for standard device
configurations. If the error persists, please contact the FTDI support department.

4. Windows 98SE complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device driver is WHQL
certified. If a driver is not certified, there will be no .cat files available. When installing drivers in Windows
98SE or Windows ME, the user is prompted to locate the .cat files if the operating system cannot find them.
If the driver is not certified but you wish to install it anyway, the files may be skipped by clicking the "Skip"
button.

5. Windows 98SE complains about missing ftccomms.vxd file
This can occur when the USB Composite driver has been installed if the user has not browsed to the

location of the driver files. If this message appears, do not skip it but browse to the driver file location. The
wizard will then be able to correctly install the device.

26
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Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. Once the composite driver has been installed the
Found New Hardware Wizard will launch. Click "Next" to proceed with the installation.

Found New Hardware Wizard

Welcome to the Found New

Q Hardware Wizard

This wizard helps you instal a device driver for 2
hardware device.

To continue, click Next.

¢ Back l MNest > I Cancel

Select "Search for a suitable driver for my device (recommended)" as shown below and then click "Next".

27
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Found New Hardware Wizard N

Install Hardware Device Drivers ‘\
A device driver is a software program that enables a hardware device to work with \?
an operating system.

This wizard will complete the installation for this device;

@ USB <-> Serial Cable

A device driver is a software program that makes a hardware device work. Windows
needs diver files for your new device. Ta loz ate driver files and complete the
installation click Next.

What do you want the wizard to do?
¢ Search for a suitable driver for my device (recommended)

" Display a list of the known drivers for this device so that | can choose a specific
diiver

< Back I Nexst > I Cancel

Check the box next to "Specify a location" and uncheck all others as shown below. Clicking "Next" displays a
dialog box for you to enter to the location of the drivers.

Found New Hardware Wizard

Locate Driver Files
Where do you want Windows to search for driver files? \?

Y/
{/

Search for driver files for the following hardware device:

@ USB <-> Serial Cable

The wizard searches for suitable drivers in its driver database on your computer and in
any of the following optional search locatiors that you specify.

To startthe search, click Nexst. If you are searching on a floppy disk or CD-ROM drive,
insert the floppy disk or CD before clicking Nest.

Optional search locations:
I Floppy disk drives
[~ CD-ROM drives
IV Specify a location
I Microsoft Windows Update

< Back I Nest > I Cancel
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51
Insert the manufacturer's installation disk into the drive oK I
g selected, and then click OK.
Cancel I

Copy manufacturer's files from:

|C:ACDM 2.00.00

=l | Browse. .. I

Click "Browse" to display an open file dialog box.

Locate File i

Look in: [ =y COM 2.00.00 v « ® ek

FTDIBUS. INF
FTDIPORT.INF

History

Desktop

w

My Documents

My Computer
e

=

= [FTDIBUS.INF
My Network P...

File name:

Files of type:

=
K|

ISetup Information [%.inf)

| Open I
Cancel I

Locate the folder containing the latest drivers downloaded from the FTDI web site above and click "Open”,

then click "OK". The PC auto selects the correct INF file, in this case FTDIBUS.INF.

Once Windows has found the required driver .INF file, click "Next" to proceed.
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Found New Hardware Wizard

Driver Files Search Results \\
The wizard has finished searching for driver files for your hardware device. \?

The wizard found a driver for the following device:

@ LUSB <-> Serial Cable

\Windows found a driver for this device. To istall the driver Windows found, click Next.

= c:\edm 2.00.00\tdibus. inf

< Back I Nest > I Cancel

Windows should then display a message indicating that the installation was successful. Click "Finish" to
complete the installation for the serial converter driver for this port of the device. The COM port emulation
driver must be installed after this has completed.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

S

N USE Serial Converter

Windows has finished installing the software for this device.

To close this wizard, click Finish.

< Back I Finish I Zancel
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By examining the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and
click "Device Manger...") and viewing by connection ("View > Devices by connection"), the device appears
as a "USB Serial Converter" with an additional COM port with the label "USB Serial Port".

Lol
| acton vew || &= = =@ @ | &

% B Irtel(R) E2801EB LPC Interface Controller - 2400 -]
=1 [ intel(R) 82801EB PCI Bridge - 244E

HY Intel(R) PROJ100 VE Network Connecion

B9 Realtek RTLB139/810x Fardy Fast Ethernet NIC

g Intel(R) 82601EB SMBus Controller - 24D2

+- Intel(R) 82801EB Likra ATA Storage Controlers
&Y Intel(R) 82801EE Ukra ATA Storage Controlers
% €% Intel(R) 52601EB USB Universal Host Controller - 24D2
+ & Intel(R) 82801EE USB Universal Host Condroller - 24D4
=) &2 Intel(R) 82801EB USE Universal Host Condroller - 24D7

T RooL Hub
=68 USE Serial Converter
-~ USB Serial Port (COM3)
& 6% I EE P ERE SRS e#TO5L Controller - 24DE
+ Lé Intel(R) 82865G Graphics Controller
B Intel(R) 828565G\PEYP Processar to IfO Centroller - 2570
Q- Realtek AC'S7 Audio
=) cystem board
¢ Audio Codecs =
- Legacy sudio Drivers
- Legacy Video Capture Devices

[ | cqical Dsk Manager
3 Media Centrol Devices :]

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the Add/Remove
Programs utility as this uses the FTDI driver uninstaller program to remove files and registry entries to leave
a clean system. Other methods may leave fragments of the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel\Add/Remove Programs ".Select "FTDI
USB Serial Converter Drivers" from the list of installed programs.

% Add/Remove Programs )

,@ FTDI USB Serlal Converter Drivers

or support inform

To chang program or remove it From your
computer, click Change/Remove.

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the
uninstaller or "Cancel" to exit.

FTDI Uninstaller i x|

If your USB device is connected, please unplug it now ...

Press Continue to uninstall the drivers, or Cancel to quit.
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When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button
will change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller ] 7 ﬁl

Uninstalling ¥ID_0403&PID_6010

Deleting registry entries ...
Deleting files ...

Press Finish to exit.

Finish |
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Troubleshooting

1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USBView utility from the FTDI web site. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed for that device without either
re-programming the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please
note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your
company should be used in the EEPROM and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy
it. This usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and
re-plugging the device may allow the device to function properly without restarting. Restarting the machine
will allow the device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices),
or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being
incorrectly installed. Please refer to the example schematics on the FTDI web site for standard device
configurations.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the FTDI website and
unzip them, the critical files in the driver package are:

ftdi_ser.dll - the VCP driver file

FTDIPORT.inf - user changeable file to allow devices with custom VID and PID combinations to be
installed

Copy all of the unzipped files to the \\Windows directory on the PDA.

If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or Compact Flash host
card), make sure that it is connected and installed before proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box to direct
Windows CE to the driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file name is
incorrect, the driver will not be found and the device will not function.

=| Enter the name of the device
driver for this device. For

v| information, see the device
manufacturer's documentation,

| 58

| 0K | | Cancel |

1231({2(3[4]5 0f-|=4
Tabjqjwie[r|t]y[u[ifo[p|[]]
CAP[a[s[d[f]a[n[j[k[1[;]"]
Shift|z [x [c[v[b[n[m][,[.[7]«
Ctifai|* [\ ] [$]t]]

&)

The device installation is now complete. The installation may be verified using the test program
available form the Utilities page of the FTDI website.
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is connected for the first
time

If the "Unidentified USB Device" dialog is not displayed when the device is connected for the first time, it is
likely that the PDA does not have a USB host capability or that the host is not installed correctly. Many PDAs
require some form of adaptor (USB host cable, presentation pack or Compact Flash USB host card) to
provide the USB host capability that FTDI devices require.

2. "Error installing USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

£ | unidentified USB D & x 10:36

(® sunday, June 01,2003
F=] Tap here to set owner information

B No upcoming appointments
= Unidentified USB Device

a* Error installing USE driver
frdi_d2xx

ok

New Tools Accounts @ %

The driver name has been misspelt. The ".dIl" file extension may be required for some platforms. The
required driver files are not in the \Windows directory. The driver file is in the wrong binary format.
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

#0 | Unidentified USB D < % 12:17

(® sunday, June 01, 2003
F=] Tap here to set owner infarmation

B No upcoming appointments

a1Uniu:k3ntiﬁed USB Device

ok

| Enor installing USB driver

New Tools Accounts ,@ %

=8

The driver name has been miss pelt - The ".dIlI" file extension may be required for some platforms - The
required driver files are not in the \Windows directory - The driver file is in the wrong binary format

4. "Unidentified USB Device" appears each time the driver name is entered

This error can be caused when the VID and PID listed in the INF file does not match the VID and PID
combination programmed into the device. It can also be caused if the INF file has not been copied to the

\\Windows directory.

£ |unidentified USB D & o 10:38

(® sunday, June 01, 2003

£ |unidentified USB D & ox 12:04

(@ sunday, June 01, 2003

= Enter the name of the davice
&= driver for this device, For
v| information, see the device
manufacturer’s docurmentation,

ftd_d2f

[Cok ] [ cancel |

Unidentified USB Device

% Enter the name of the davice
driver for this device. For

lv] information, see the device

o manufacturer's documentation,

1(2|3(4|5(6(7|8|9(0|-|=|4 | 3|4/5 6|7 :0
Tabla[wle[r[t]y[u]i]o[p[L]] Tab[q[wle[r[t]y[u]i]o]p|L]]
CAP|a|s|d|f|g|h JEEH B CAPla |s|d|f|lalh|)|k|V]|;]"
Shift| z [® |c|v(binm|,|.|/]|+ Shift|z (% |c|v|binm|,|.|/|+
ctfaal * [\] [4]t]<]~ ctijai * [\] [+2]<]>

=)
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One way to check this is to use the Registry editor that comes with Embedded Visual C++ (or a suitable
registry editor on the Windows CE device itself) to check for the registry settings (Tools > Remote Registry
Editor). With ActiveSync running, connect to your device then look at the registry setting
KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\

£ Windows CE Remote Registry Editor = =ial x|

Regstry £ Mew Comnection Hep

e EEEREEED
¥ B My Conputer )
= 9 POCKET PC 2003 Device
ol () MKEY_CLASSES_ROOT
) () HKEY_CURRENT USER
[=H ) HKEY_LOCAL_MACHING
# ] Coom
& ) CorbroParel
= Givers
G ) Az
1] Eulin
s (3 Display

1 0as
ivahe rot set)

o
:

) Chentlerenrs

& () securky

= ) Services
@] 5d

() SOFTWARE
* -] Sysam

= wa

o) Talank

{POCKET 5C 2003 Devica|HEY_LOCAL_HACHING Drrver sl IS8 cadCherks\ L027_24622] R g
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In this case, the entry is 1027_24592, which corresponds to a VID of 0x0403 (1027) and a PID of 0x6010
(24592) device. If this is not the device to be installed, the message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and PID. For the D2XX
drivers, edit the bold red entries in the following line in the ftd2xx.inf file:

[FtdiHw] "FTDI Dual device"=FTDI,USB\&VID_0403&PID_6010

For the VCP drivers, edit the bold red entries in the following line in the FTDIPORT.Inf:

[FtdiHw] %VID_0403&PID_6010.DeviceDesc%=FtdiPort232,FTDIBUS\COMPORT&VID_0403&PID_6010

5. Device can write but cannot read

If the hardware does not work correctly under Windows 2000 or Windows XP then the problem is most likely
a hardware issue. Windows CE is not very tolerant of noisy hardware, so even "good" designs for Windows
2000 and XP may experience problems with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support different bulk transfer
sizes. One method to attempt to resolve this is to reduce In Transfer Size to 64. This is the smallest possible
transfer size and will have a severe effect on performance, but should resolve most other issues. Larger
values may be tried to improve performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can result in the device
running at a different Baud rate to the one intended. The Baud rate can be verified easily by transferring
data from PDA/target to HyperTerminal. Some host device drivers have been seen to lose packets of data
which would also cause this problem.

7. Driver isn't sending or receiving any data

Sending and receiving data can be tested with an application such as VCPTest. However, this will not

highlight problems due to incorrect Baud rates. To check for the wrong Baud rate being set, try to transfer
data from the PDA/target to and from HyperTerminal.

40



USB to RS-485U1 Adapter User’s Manual

Windows XP Installation Guide

1. Installing Via the Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the Uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from the Internet. This
can be done by either removing the network cable from your PC or by disabling your network card by going
to the "Control Panel\Network and Dial Up Connections", right clicking on the appropriate connection and
selecting "Disable" from the menu. The connection can be re enabled after the installation is complete. This
is not necessary under Windows XP SP 2 if configured to ask before connecting to Windows Update.
Windows XP SP 2 can have the settings for Windows Update changed through "Control Panel\System" then
select the "Hardware" tab and click "Windows Update".

Connect the device to a spare USB port on your PC. If there is no available Internet connection or Windows
XP SP 2 is configured to ask before connecting to Windows Update, the screen shown in Figure

2.1 is displayed. Select "No, not this time" from the options available and then click "Next" to proceed with
the installation. If there is an available Internet connection, Windows XP will silently connect to the Windows
Update website and install any suitable driver it finds for the device in preference to the driver manually
selected.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for current and updated software by

looking on your computer, on the hardware installation CD, or on
the Windows Update ‘Web site [with your permission).

Online privacy information

Can Windows connect to Windows Update to search for
software?

O Yes, this time only
(O Yes, now and every time | connect a device

® &

Click Next to continue.

[ Next > ][ Cancel ]

Figure 2.1

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below and then click "Next".
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Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM
2.02.04" in Figure 2.3 below) or browse to it by clicking the browse button. Once the file path has been
entered in the box, click next to proceed.

Found New Hardware Wizard

This wizard helps you install software for:

USB Serial Converter

') If your hardware came with an installation CD
&2 or floppy disk. insert it now.

‘What do you want the wizard to do?

O Install the software automatically (Recommended)

Click Next to continue.

[ < Back ][ Next > ][ Cancel

Figure 2.2

Found New Hardware Wizard

Please choose your search and installation options. ‘\

¥

() Search for the best driver in these locations.

Use the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[[] Search removable media (floppy, CD-ROM...)

Include this location in the search:

CACDM 2.02.04 v

O Don't search. | will choose the driver to install

Choose this option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ < Back ][ Next > ][ Cancel

Figure 2.3

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed,
the message dialogue shown in Figure 2.4 will be displayed unless installing a Microsoft WHQL certified
driver. Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file

signature warnings, no message will appear.

The screen shown in Figure 2.5 will be displayed as Windows XP copies the required driver files.
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Hardware Installation

1 E The software you are installing for this hardware:
.

USE Serial Converter

has not passed Windows Logo testing to verify its compatibility with

this version of Windows. [Tell me why this testing is important)

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ LContinue Anyway ] [ STOP Installation |

Figure 2.4

Found New Hardware Wizard

Please wait while the wizard installs the software... ‘Q\

N

@ USB Serial Converter

L =/
ftd2xx.dll
To CAWINDOWSsystem32
{CCCCCCCT LT )
Figure 2.5

Windows should then display a message indicating that the installation was successful (Figure 2.6). Click
"Finish" to complete the installation for the first port of the device.

The Found New Hardware Wizard will launch automatically to install the COM port emulation drivers. As
above, select "No, not this time" From the options and click "Next" to proceed with the installation (Figure
2.7).
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

% USB Serial Converter

Click Finish to close the wizard.

| Finish

Figure 2.6

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for current and updated software by

looking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permission).

Online privacy information

Can Windows connect to Windows Update to search for
software?

(O Yes, this time only
(O Yes, now and every time | connect a device

O}

Click Next to continue.

[ Next > ][ Cancel

Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM
2.02.04" in figure 2.9 below) or browse to it by clicking the browse button. Once the file path has been
entered in the box, click next to proceed.
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Found New Hardware Wizard

This wizard helps you install software for:

USB Serial Port

,') If your hardware came with an installation CD
&2 or floppy disk. insert it now.

‘What do you want the wizard to do?

O Install the software automatically (Recommended)
@ilnstall from a list or specific lcation [Advanced}

Click Next to continue.

[ < Back ][ Next > ][ Cancel

Figure 2.8

Found New Hardware Wizard

Please choose your search and installation options. \

&

Use the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[[] Search removable media (floppy, CD-ROM...)

Include this location in the search:

[CACDM 2.02.04 v

O Don't search. | will choose the driver to install

Choose this option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ < Back ][ Next > ][ Cancel ]

Figure 2.9

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed,
the message dialogue shown in Figure 2.10 will be displayed unless installing a Microsoft WHQL certified
driver. Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file

signature warnings, no message will appear.

The screen shown in Figure 2.11 will be displayed as Windows XP copies the required driver files.
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Hardware Installation

1 E The software you are installing for this hardware:
L
USB Serial Port

has not passed Windows Logo testing to verify its compatibility with

this version of Windows. [Tell me why this testing is important]

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either i diately or in the fut Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has

passed Windows Logo testing.

[ Continue Anyway ] | STOP Installation |

Figure 2.10

Found New Hardware Wizard

Please wait while the wizard installs the software...

Y/
{/

3 USE Serial Port
=

e, T B

ftserui2.dil

To C:AWINDOWS \system32

OO )
Figure 2.11

Windows should then display a message indicating that the installation was successful (Figure 2.12). Click
"Finish" to complete the installation for the first port of the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manger") and select "View > Devices by Connection”, the device appears as a "USB Serial
Converter" with an additional COM port with the label "USB Serial Port" (Figure 2.13).
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

3 USB Serial Port
|

Click Finish to close the wizard.

Figure 2.12

Device Manager

File Action View Help

==
"¢ ACPIFixed Feature Button ~
#® Genuine Intel(R) CPU 2160 @ 1.80GHz
& Genuine Intel(R) CPU 2160 @ 1.80GHz
= '§ PClbus

] 3” Intel{R) 946GZ Express Chipset Family
] '_4 Intel(R) 82801 PCI Bridge - 244E
¢ Intel{R) 82801G (ICH7 Family) SMBus Controller - 27DA
+ Intel{R) 82801G (ICH7 Family) USB Universal Host Controller - 27C8
=] Intel{R) 82801G (ICH7 Family) USB Universal Host Controller - 27C9
€ UsSB Raakub
B Serial Converter
USE Serial Port {(COM3)
Intel(R 3 Y056 Universal Host Controller - 27CA
Intel{R) 828016 (ICH? Family) USB Universal Host Controller - 27CE
Intel{R) 82801G (ICH? Family) USB2 Enhanced Host Controller - 27CC
»j Intel{R) 8§2801GB{GR (ICH7 Family) LPC Interface Controller - 2768
&) Intel(R) 82801GB{GR/GH (ICH7 Family) Serial ATA Storage Controller - 27C0
»_J Intel{R) 946GZ{PLJGL PCI Express Root Port - 2971
»j Intel{R) 946GZ{PLJGL Processor to IfO Controller - 2970
o _J Microsoft UAA Bus Driver for High Definition Audio
4

F

Motherboard resources

<

Figure 2.13

£ Device Manager

File Action View Help

==
"¢ ACPIFixed Feature Button ~
¥ Genuine Intel(R) CPU 2160 @ 1.80GHz
& Genuine Intel(R) CPU 2160 @ 1.80GHz
= '§ PCIbus

] 3” Intel{R) 946GZ Express Chipset Family
G _{ Intel(R) 82801 PCI Bridge - 244E
¢ Intel{R) 82801G (ICH7 Family) SMBus Controller - 27D
+ Intel{R) 82801G (ICH7 Family) USE Universal Host Controller - 27C8
=] Intel{R) 82801G (ICH7 Family) USE Universal Host Controller - 27C9

USE Serial Port {(COM3)
Y056 Universal Host Controller - 27CA
Intel{R) 828016 (ICH? Family) USE Universal Host Controller - 27CE
Intel{R) 82801G (ICH? Family) USB2 Enhanced Host Controller - 27CC
»j Intel{R) 82801GB{GR (ICH7 Family) LPC Interface Controller - 2768
&) Intel(R) 82801GB{GR/GH (ICH7 Family) Serial ATA Storage Controller - 27C0
»_J Intel{R) 946GZ{PLJGL PCI Express Root Port - 2971
»j Intel{R) 946GZ{PLJGL Processor to IfO Controller - 2970
£ _J Microsoft UAA Bus Driver for High Definition Audio
'¢ Motherboard resources

F

<

Figure 2.14

47



USB to RS-485U1 Adapter User’s Manual

2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the driver package using
the Microsoft Driver Install Frameworks (DIFx) tools. The simplest tool provided is the Driver Package
Installer (DPInst). When placed in the same directory as the INF files for the driver package, simply run
DPInst.exe and the certified driver package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files. DPInst has
separate executables for 32bit and 64bit installation. This means that if a single solution is desired for 32bit
and 64bit systems, the developer must be able to detect which version of DPInst is required for the system
the driver is being installed on.

For more information on DPInst, see the FTDI Windows Driver Installation application note.

3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install the driver from the
Windows Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in 2.1 Installing Via
The New Hardware Wizard, except that the “Yes, this time only” or “Yes, now and every time | connect a
device” option should be selected on the first screen of the wizard when asked if Windows Update should be
checked for a driver. If the wizard finds a matching driver on Windows Update, the driver will be
automatically downloaded and installed for the device.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed using the Device
Manager by simply right clicking on the device and selecting "Uninstall". This will delete the associated
registry entries for that device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually or by using a
custom application. OEM INF and PNF files are located in the Windows\Inf directory and can be identified by
searching for a VID and PID string matching the device installed e.g. VID_0403&PID_6001. Once the
matching OEM INF files are found (e.g. oem10.inf for FTDIBUS.INF and oem1l.inf for FTDIPORT.INF), the
corresponding PNF files must also be removed (e.g. oem10.pnf and oem11.pnf). Driver files are located in
the Windows\System32 and Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

If the VCP driver has been installed, the COM port driver should be removed before the bus driver. If the bus
is removed first, the COM port will no longer appear in the Device Manager.

If the driver files are deleted while other installed devices still require them those devices will not work
correctly. This can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the
missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device
manager to show phantom devices. This can also allow a virtual COM port to be uninstalled if the bus layer
has been removed first. Instructions on how to display phantom devices are given in the Advanced Driver
Options application note.
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Troubleshooting

1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USB View utility from the FTDI web site. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or modifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use
by your company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy
it. This usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and
re-plug the device may allow the device to function properly without restarting. Restarting the machine will
allow the device to work correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices),
or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being

incorrectly installed.

Please refer to the example schematics on the FTDI web site for standard device configurations. If the error
persists, please contact the FTDI support department.

4. Windows XP Displays an Error And Then Terminates Installation
If the following screen is displayed with this message, Windows XP has been configured to block the

installation of any drivers that are not WHQL certified.
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Hardware Installation

6 The software you are nstalling for this hardware
USE Senal Converter

has not paszed Windows Logo testing to verfy its compatibilty
with this version of Windows. [Tell me why thes testing i important]

This hardware will not be installed Contact pous system
admirustrator.

Figure 4.1

Two options are available to successfully install the device. Either a certified version of the driver can be
installed (if available) or the driver signing options can be changed to either warn or ignore to allow the
installation to complete.

To change the current driver signing setting, go to "Control Panel\System", click on the "Hardware" tab and
then click "Driver Signing". The desired signing option may then be selected.

51



USB to RS-485U1 Adapter User’s Manual

Windows Vista (Win 7, 8, 8.1, 10, 11) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA (Win 7, 8, 8.1, 10, 11) will silently connect to the
Windows Update website and install any suitable driver it finds for the device in preference to the driver
manually selected. If no suitable driver is automatically found then the following procedure should be

followed.

|-"] Found New Hardware

Windows needs to install driver software for your TTL232R
Tester

@ Locate and install driver software (recommended)
Windows will guide you through the process of installing driver software
for your device.

2 Ask me again later
Windows will ask again the next time you plug in your device or log on.

& Don't show this message again for this device
Your device will not function until you install driver software.

Cancel

When locate and install driver software (recommended)"” is selected the following screen will appear. Note:
the text “TTL Tester” is replaced with the description of the customer hardware.

u L Found New Hardware - TTL232R Tester

Insert the disc that came with your TTL232R Tester

If you have the disc that came with your device, insert it now. Windows will automatically
search the disc for driver software.

< Idon't have the disc. Show me other options.

Cancel

Select “I don’t have the disk. Show me other options” The next screen will appear.
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Windows couldn’t find driver software for your device

< Check for a solution

Windows will check to see if there are steps you can take to get your device
working,

% Browse my computer for driver software {(advanced)
Locate and install driver software manually,

Select "Browse computer for drver software (advanced)". The next screen will appear.

Browse for driver software on your computer

Search for driver software in this location:

[ Lo

WV Include subfelders
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Browse to the folder where the CDM driver has been stored (when uncompressed) and press “Next”

The example shown above uses a folder on the desktop.

The next screen will appear

) o Found New Hardware - TTL232R Tester

Installing driver software..

This screen will automatically complete and then change to the one below:

\_) A FoundNew Hardware - USB Serial Converter

The software for this device has been successfully installed
Windows has finished installing the driver software for this device:

USB Serial Converter
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The bus layer of the driver is now installed.

After the driver is installed it is important to determine which COM port has been assignhed to the device for
configuring the application that will use the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manager") and select "View > Devices by Connection", the device appears as a" USB Serial
Converter" with an additional COM port with the label "USB Serial Port".

% Device Manager = e &S
File Action View Help

el A0l 7 o

.- & Computer
v ¢ Disk drves

» B, Display adapters
7 g DVD/CD-ROM drives
+ =g Floppy disk drives
= 4 Floppy drive controllers
- 'vl‘H Human Interface Devices
- g IDE ATAJATAP] controllers
@ [EEE 1334 Bus host controllers
i == Keyboards
3 i'j Mice and other pointing devices
5 I Monitors
+- &% Network adapters
5 I Portable Devices
"3 Ports (COM & LPT)
TZT Communications Port (COML)
'Z7 Printer Port (LPT1)
'Y USB Senal Port {COM3)
7 [ Processors
= % Sound, video and game controllers
&, High Definition Audio Device

=€ Storage controllers
< A System devices

= @ Universal Serial Bus controllers

This screen shows the device connected to COM3.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:

www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”".
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Uninstalling Instruction

With the release of Microsoft Windows Vista, the FTDI uninstaller has been rendered unusable due to
Windows Resource Protection preventing the executable from deleting driver files and associated registry
values. Vista will only allow the system itself to modify files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be removed using the Device
Manager by simply right clicking on the mouse and selecting "Uninstall". This will delete the associated
registry entries for that device only. Vista provides an automatic method to delete driver

.

Confirrn Device Uninstall |

USE Senal Converner

VWaming: You are sbout to uninstall this dewvice from your system.

|| Delete the driver software for this device

Windows 2000, XP and Server 2003 do not have this check box, so driver files and OEM INF and PNF files
must be removed manually or by using a custom application.

Some points to note about the new uninstallation method:

If the VCP driver has been installed, the COM port driver should be uninstalled before the bus driver. If the
bus is removed first, the COM port will no longer appear in the Device Manager.

If the files are deleted while other installed devices still require them those devices will not work correctly.
This can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing
files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device

manager to show phantom devices. This also allows a virtual COM port to be uninstalled if the bus layer has

been removed first.
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Troubleshooting

1. Windows VISTA can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USB View utility from the FTDI web site. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note
that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by the
customer should be used in the EEPROM and INF files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred to as "phantom
devices". These devices are not usually displayed in the device manager, but can be made to be displayed
as though they are attached. This allows device properties to be changed or devices to be uninstalled via
Device Manger even though the device is not physically connected to the PC.

To display phantom devices in Device Manager, a hew system variable is required. Open "Control Panel >
System" then select the "Advanced" tab and click "Environment Variables". In the System Variables section
(NOT THE USER VARIABLES SECTION), click "New..." to display the following window:

Edit System Variable (=25
Variable name: DevMar_Show_NonPresent_Devices
Variable value: fl
OK ‘ : Cancel

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1, then
click OK.

Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click "Device

Manager...", or "Control Panel > Device Manger" in Vista) and select "View > Show Hidden Devices".

Device Manager will then show all hidden and phantom devices available on that PC as shaded.
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3. Windows Vista (Win 7, 8, 8.1, 10, 11) shows a warning that the driver is not certified

If the driver is not certified then a pop up window such as shown below will be displayed.

&) windows Security

@ Windows can't verify the publisher of this driver software

«» Don't install this driver software
You should check your manufacturer's webske for updated driver software for yvour
device.

«» Install this driver software anyway
Only instalk driver software obtained from your manufacturer's website or disc.
Unsigned software from other sources may harm your computer or steal information.

__v_J See detais

If you are certain of the source of the driver the warning can be ignored and you can continue installation by

selecting “Install this driver software anyway”.

4. Driver will not install on VISTA x64

VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied by FTDI will work
with VID 0403 and PID 6001 for FT232 and FT245 devices.

If you have a product where the manufacture has customized the driver but has not recertified it, then the
driver will not load. You should contact your vendor to determine if they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the hard disk. The
driver is now available in disk image (.dmg) format. Run the installer by double clicking on the
FTDIUSBSerialDriver.dmg icon.

rQ (X&) Install FTDIUSBSerialDriver Kernel Extension

Welcome to the FTDIUSBSerialDriver Kernel Extension Installer

| Welcome to the Mac OS X Installation Program. You will be
=] Il{troduction guided through the steps necessary to install this software.

® Rexd Me

® Select Destination

® Installatian Type

® Installing [

® Finish Up A

h

Go Back { Continue |

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.
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ZQ 0.0 Install FTDIUSBSerialDriver Kernel Extension J

£

© Introduction
© Read Me
© Select Destination

Install Software

O Installation Type
© Installing The software was successfully installed

© Finish Up A B -

Click Restart to finish installing the software.

When the computer has rebooted, plug in the device. If the device is installed properly, you will see entries in
the /dev directory:

/dev/cu.usbserial-XXXxXxXxXxX
/dev/tty.usbserial-xxXxxxxxx

Where xxxxxxxx is either the device's serial number or, for unserialized devices, a location string that
depends on which USB port your device is connected to. The Terminal application can be launched by
selecting Go > Applications > Utilities > Terminal. Type the following lines in the Terminal window to produce
the file list:

cd /dev
Is-|

If you run the application System Preferences and select Network (Go > Applications > System Preferences
> Network), you should see the text "New Port Detected".
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. . New Port Detected
ﬂ . A new network port has been detected:

usbserial-1B22

Please verify that it is configured correctly, then

press Apply Now to activate ic.

Click OK and select Network Port Configurations from the show list. The new port can be enabled from this
screen by checking the on box and clicking Apply Now.

@60 Network o)

« My O

Show All | Displays Sound Network Startup Disk

Location: ( Automatic E

Show: | Network Port Configurations 14

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

| On | Port Configurations

B usbserial-1B22

S Internal Modem New...
g Built-in Ethernet

it

Duplicate

@

L
Click the lock to prevent further changes. C Assist me... ) ( Apply Now )
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At this point, it is possible to exit Network and use the device as a COM port. If you wish to set the device up
a modem for an Internet connection, select the new port from the show list to display the window below.

r - ]
enn Network o
¢« = H & =
Show All Di)splays Sound Network Startup Disk
Location: = Automatic 9
Show: usbserial-1822 )
[ PPP . TCP/IP Proxies Modem
Service Provider: (Optional)
Account Name:
Password:
Telephone Number:!
Alternate Number: (Optional)

"1 Save password
Checking 11is box allows all users of this computer to
access this Internet account without entering a password.

(PPPOptions... ) (' Dial Now... )

)

1 7
JTQK Click the lock to prevent further changes. { Assistme... ) Apply Now

Entries for this screen are specific to the Internet account for each user. If you do not know the required
details, contact your Internet service provide

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a reserved username
that has the privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the following commands at the
command prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select Network. Selecting
Network Port Configurations from the Show menu will display the port as greyed out. Select the uninstalled
port and click Delete. Confirm the deletion to remove the port.

r —= —3 |
e6n Network =
“ E & &
Show All D;spluvs Sound Network Startup Disk
Location: = Automatic & ]

Show: Network Port Configurations ﬂ

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On  Port Configurations

Jsbserial-182:

# Internal Modem (__ New.. )
@ Built-in Ethernet T
( Delete... )
©)
P e~
] Click the lock to prevent further changes. [ Assistme... ) Apply Now
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Troubleshooting

1. How do | know what my device ID is?

Launch the System Profiler utility, or Apple System Profiler for earlier versions of OS X. This can be
accessed by going to the Finder and selecting Applications from the Go menu, then open the Utilities folder.

Select USB under Hardware in the pane to the left and then select the appropriate device from the USB
Device Tree. In the screen shot below (from OS 10.3), the device has a device ID given by:

Vendor Name: FTDI
Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

‘@m6e System Profile Y
Andy's eMac 10/01/2005 08:37
Contents USB Device Tree
¥ Hardware USB Bus
Memory ¥ USB Bus
PCI/AGP Cards ¥ Hub in Apple Extended USB Keyboard
ATA
SCSI Apple Optical USE Mouse
use Apple Exterded USB Keyboard
FireWire USB Bus
AirPart Card USB High-Speed EBus
Modems
v Software
Applicatians
EXteasions USB <-> Serial: ’
Network
Logs ~ Vendor Name: FIDI
Speed: Up 10 12 Mb/sec
Product iD 24577 (36001)

Bus Pawer (mA): 100

If the device does not work after installing the driver, it is likely to be because the PID is not supported by the
driver. If this is the case, contact FTDI Support with the PID that needs to be added to the driver. If the VID is
not 0x0403, it is likely that the device is not an FTDI device and we cannot support it.
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2. The device does not appear in the /dev directory or the text "New Port Detected" is not
displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable the EEPROM so that the
device reverts to its default device ID, then replug. To get support for your device ID built into FTDI
USBSerial Driver, contact FTDI quoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported in FTDI USB
Serial Driver

An ownership or permissions problem is preventing the system from making the device accessible. Check
that the driver is owned by root and wheel. The most common symptom is the group for FTDI USBSerial
Driver is not wheel. To change the group, login as root and perform the following script in a Terminal window
(Go > Applications > Utilities > Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.

4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities > Terminal .The terminal window
is equivalent to a DOS prompt in Windows.
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6. Regulatory Compliance

Disclaimer

Information in this document is subject to change without notice. The manufacturer does not make any representations
or warranties (implied or otherwise) regarding the accuracy and completeness of this document and shall in no event
be liable for any loss of profit or any other commercial damage, including but not limited to special, incidental,
consequential, or other damages.

No part of this document may be reproduced or transmitted in any form by any means, electronic or mechanical,
including photocopying, recording or information recording and retrieval systems without the express written
permission of the manufacturer.

All brand names and product names used in this document are trademarks, or registered trademarks of their
respective holders.

CE Certification
This equipment complies with the requirements relating to electromagnetic compatibility.
It has been manufactured under the scope of ROHS compliance.

FCC Compliance Statement

This equipment generates and uses radio frequency and may cause interference to radio and television reception if not
installed and used properly. This equipment has been tested and found to comply with the limits of a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation.

You are cautioned that changes or modification not expressly approved by the party responsible for compliance could
void your authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that may cause undesired operation

E WEEE (Waste of Electrical and Electronic Equipment),
— Recycling of Electronic Products

In 2006 the European Union introduced regulations (WEEE) for the collection and recycling of all waste electrical and
electronic equipment. It is no longer allowable to simply throw away electrical and electronic equipment. Instead, these
products must enter the recycling process.

Each individual EU member state has implemented the WEEE regulations into national law in slightly different ways.
Please follow your national law when you want to dispose or any electrical or electronic products. More details can be
obtained from your national WEEE recycling agency.
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